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Introduction to RAS

In this class you will learn%

• Key terms and concepts.

• RAS basic skills for creating new rules and 
amending rules, saving RAS documents, 
and working with text and levels.

• The process of requesting and downloading 
rules from the Rule Filers Website.
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For any questions about 

Electronic Rule Filing,

call the 

ERF Help Desk

614-387-2078

Monday – Friday
8:00 am – 5:00 pm

Email:  erfhelpdesk@lsc.state.oh.us

ERF Resources
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LSC Rule Drafting Manual:

www.lsc.state.oh.us/rules/

JCARR Procedures Manual:

www.jcarr.state.oh.us

This class does not cover *procedures* relating 
to the drafting and filing of rules (in other words, 

you will learn “how” but not “why”).

For procedural information, refer to the LSC and 
JCARR manuals, or contact those agencies 
directly.

ERF Resources
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Website Addresses

ERF Resources

Register of Ohio:  www.registerofohio.state.oh.us
- Link to the Rule Filers Website

- Link to the ERF Website

- Notices of upcoming public hearings on proposed rules

- Browse and search proposed and adopted rules

- Helpful information about rule making in Ohio

ERF Website: https://erf.registerofohio.state.oh.us
- Create packages and file rules

JCARR Dates Calculator: http://www.jcarr.state.oh.us
- Determine public hearing and effective dates based on a specified event date.



Key Terms and Concepts
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ERF Website

(Register of Ohio)

�The Electronic Rule-Filing System 

Consists of:
(1) The Rule Filers Website – Where you request and download prepared 

rules.

(2) The Rule Authoring Software: RAS3 - Software you use to create and edit 
rules.

(3) The ERF Website – Where you create packages and file rules.
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In order to make rules that were compatible with the 
Electronic Rule-Filing System, we needed a way to create 
rules that:  

1) could be transmitted via the Internet and

2) adhered to the format described in the LSC Rule 
Drafting Manual  

The solution was RAS: rule-drafting software in which a 
user can create and save rules in a file format called XML.

�Why RAS?
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XML stands for eXtensible Markup Language.

XML is a universal language for sending and receiving 
documents via the Internet and for creating documents that must 
adhere to a specific structure (format).   

While other software programs, including newer versions of 

Microsoft Word, can create XML documents, only RAS-created 
XML files are compatible with the ERF Website.

�What is XML?



- Functions such as outline numbering and outline formatting are 

included to support the LSC Rule Drafting Manual guidelines.

- When rules created in RAS are saved, they are saved as XML 
files and are compatible with the ERF Website.

- Conceptually, RAS is a rules processor, not a word processor.
RAS takes control of all document, paragraph, and character 
formatting.

- Menu choices and toolbar buttons assist with rule drafting.

- Some RAS functions are available only when the cursor is in a 
specific location (“cursor position”).

These and other topics will be discussed in more detail 
throughout the class.

�How does RAS work?

11
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Loading RAS3 onto 

your PC
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Installation Instructions
*** It is recommended that a System Administrator or IT 

Personnel install the RAS3 software. ***

Minimum System Requirements:

– Winzip or other .zip file extracting software

– Adobe Reader (for previewing rules as PDF)

Installation Instructions for RAS3 using Windows: 

1. User must have permission to install software.

2. Locate and delete any existing RAS3 folder from the user’s 
home directory, if applicable. If a user has not previously 
installed RAS3, skip this step.

The RAS3 folder is located at: 

<root.\Documents and Settings\<username>\ras3 for Microsoft 
Windows 2000, XP, and 2003 users

<root>\Users\<username>\ras3 for Microsoft Windows Vista 
and 7 users
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3. Open a browser and go to the download site at:

http://ras.lis.state.oh.us/. Download the RAS3 zip file by 
clicking the link and saving the file. 

(If a user has previously installed RAS3, an error message may state that the 
zip file already exists, asking if it should be replaced. Select Yes.)

Installation Instructions
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Installation Instructions

4. Locate the downloaded zip file and use Winzip, or other zip 
extraction software, to extract the zip file into the user’s home 
directory.

Example:
Microsoft Windows 2000, XP, and 2003:

<root>\Documents and Settings\<username>
Microsoft Windows Vista and 7:

<root>\Users\<username>
A RAS3 folder will be created in the user’s home directory.

5. Locate the newly created RAS3 folder and double-click to open the 
folder. Locate the RAS.exe file; right-click and select “Create 
Shortcut.” Rename the shortcut to RAS3 by right-clicking on the 
filename and then move it to the desktop.

6. Launch the application by double-clicking on the RAS3 
shortcut on the desktop. 

If you get a prompt that reads: “The publisher could not be verified. 
Are you sure you want to run this software?” – Uncheck the 
checkbox that reads “Always ask before opening this file” and 
click Run.
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Installation Instructions

7. Once the RAS3 application has opened, you should see a panel 
titled “Navigator” in the lower right-hand corner. Double-click the   
103$0-3-01 rule filename. It will open the rule in the large edit panel 
in the middle of the screen.

8.  If the rule opens, the installation was successful. You can close the 
download page and, if you wish, delete the downloaded zip file.

9. Now that RAS3 is successfully installed on your PC, it is important 
to check that the current version of RAS3 is also installed. 

10. Check the current version of RAS3 by selecting 

the Help Tab and then the About RAS option 

from the drop-down menu.
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Installation Instructions

11. An About RAS3 dialog box will appear.

12.  The version of RAS3 currently loaded on your PC will display.

13. If Version: 1.0.2 appears, the installation process is complete and 
the latest version of RAS3 is loaded on your PC. If a version 
number other than 1.0.2 appears, follow the instructions on slide 22
to install the latest version of RAS3.

NOTE: The current version of RAS3 should be 1.0.2.
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Check for and 

Install RAS3 Updates



Check the Current Version of RAS3

To display the current version of RAS installed on your computer:

1. Select the Help Tab.

2. From the drop-down box, select the 

About RAS option.

3.    The following box will appear displaying the version number:

19



Check for and Install RAS3 Software 

Updates
To check for new RAS3 software updates:

1. Select the Help Tab.

2. From the drop-down box, select the Check For 

Updates option.

3. If at least one new software update exists, a message “New 

Update has been found” will appear. (Follow steps 4. – 8.) If no 
updates are found, skip to step 9.

4. Click Finish.

5. A message asking “%do you wish to continue” will appear.

6. Click OK. 

7. A message stating that you should restart RAS3 will appear.

8. Click Restart. RAS3 will shut down and restart at which time you 
will have the latest RAS3 software version loaded on your PC and 
you can begin using RAS to work on your rules.

20



Check for RAS3 Software Updates

9. If no software updates are found, the message below will display:

10. Click OK.

21
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Getting Started
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To start RAS:  Double-click on the RAS icon on the 
desktop. The following screen appears:



24

RAS Screen Layout Panels

Edit Panel

Outline 

Panel

Navigator 

Panel
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Edit Panel

The Edit Panel will display the text and all 
components of a rule. Within this space all 

rules are created and/or amended.
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Outline Panel

The Outline Panel displays the outline of 
a rule; the various levels, sub-levels, etc. 
It is functional meaning that if you click 
on a particular level in the Outline Panel, 
the cursor will go to that location in the 
rule in the Edit Panel.
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Navigator Panel

The Navigator Panel displays a list of 
rules that a user has created and/or 
opened in RAS. Rules are listed in rule 
number order and include rules that are 
currently being worked on as well as 
those completed in the past.
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Individual panels cannot be moved around 
on the screen; however, users can slide 
the panel borders to expand and/or 
condense the size of each panel.

Moving Screen Layout Panels
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RAS has been pre-loaded with

Rule 103-3-01. 

When accessing RAS for the first time, 
note that one rule has already been 
loaded for example purposes.  In the 
Navigator Panel, Rule 103$0-3-01 is 
listed. Double-click on the rule to open it in 
the Edit Panel.
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Rule 103-3-01 displays in the Edit Panel. 
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The Outline Structure of the rule appears in 

the Outline Panel.

Notice that the Outline Structure for the 
rule is currently collapsed. This is evident 
because there is a small       box        
beside several of the levels indicating that 
there is more information. Click on a box 
to expand the Outline Structure and reveal 
the additional levels for this rule. 
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In the Navigator Panel, notice that the file path 

for the rule file also displays. 
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To close the rule, click on the     within the blue 

Rule tab.  (The     turns pink.)
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Deleting files from Navigator Panel

Deleting a file from the Navigator 
Panel only deletes the file name from 
this list. It does not delete the file 
from the “save” location; assuming 
that the file was properly saved 
initially. 
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Deleting files from Navigator Panel

Deleting a file from the Navigator Panel generates a confirmation 
message box asking the user to confirm the deletion by selecting OK

or stop the deletion by selecting Cancel. (Users should disregard the 
Preview > option.)  
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Deleting files from Navigator Panel

If the user did not perform a File, Save As when creating a new rule 
document initially, and instead saved the file via File, Save or by 
selecting the Save icon from the Toolbar; and the rule file is selected 
from the Navigator Panel for deletion, the rule file will be deleted 

from the save location. The message below will display asking the 
user to confirm the deletion by selecting OK or to stop the deletion by 
selecting Cancel. (Users should disregard the Preview > option.)  
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Menu Bar and Standard Toolbar

Standard Toolbar – Contains shortcuts for standard 
RAS actions and tools.

NOTE: All icons in the Toolbar will reveal what they do when you place the 
cursor over the icon and wait. The function for almost every icon on the 
Toolbar can also be found in one of the Menus.

Menu Bar – Contains all tools for use with RAS.



Keyboard Shortcuts

[Enter] key – Pressing the Enter key in a RAS 
document will insert a paragraph.

[Delete] key – The Delete key will strike highlighted 
text, remove new elements (i.e. graphics, page 
breaks, paragraphs, etc.), and remove new levels. 
The Delete key will delete single characters when 
new text is being typed into existing text.

[Ctrl-Enter] – Pressing the Ctrl key and the Enter

key at the same time will insert a new level at the 
same rank relative to the current cursor location.

38
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Context Bar

RAS creates and saves rules in an XML file format that 
also inserts tags “behind the scenes” to describe the 
data entered. A Context Bar appears at the bottom of 
the screen which provides information regarding the 
cursor position between these tags used by XML. There 
can be several tags listed separated by a bar (l). The 
tag name after the last bar is where the cursor is 
currently located. 
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First Step:

What type of rule are you 

working with ???

1. Existing Rule
• To be Amended
• To be Rescinded
• No Change

2. New Rule
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1. Existing Rule 

The Process of Requesting and 

Downloading Rules from the Rule 

Filers Website

www.registerofohio.state.oh.us
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ABOUT REQUESTING RULES

� Use the Rules Filers Website to request that LSC prepare the rule(s) 
you want to amend. (This process is also applicable for rescind and no 
change rules.)

� Allow at least 30 days for LSC to prepare your rules. Please plan your 
requests based on the date you need the rules for drafting, not on the 
anticipated filing date. For example, if you need the rules on August 1, 
and you need to download them on July 1 to begin drafting, you should 
request them no later than June 1.  

� The rule you download will already be in the XML format. 

� Open the rule in RAS, even if it is a rescind or no change rule, to verify 
its content. 

� If you have previously requested the rule, the request can be modified. 

NOTE: If the rule has been final filed in the last 60 days, please call the 
ERF Help Desk after entering the request to alert them the rule is being 
re-requested.
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1. Go to www.registerofohio.state.oh.us

2. Click on Rule Filers Website.
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3. Click the Rule Filing Schedule & Downloading Prepared Rules option.
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In order to request LSC to prepare a rule(s) for download:

1. Click the Submit rule filing schedule option.
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NOTE: When you click SUBMIT, one of three events may occur.

2. Complete the form and click Submit.
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Event #1: The text at the top of the form reads “Thanks for submitting the 

request.”  This means that (A) the request has been submitted to LSC for 
preparation, and (B) the rule number is not in the Website’s data file.  

Another rule number may be entered for submission, if desired.
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Event #2: The text at the top of the form reads “Invalid Rule Number.  

Please enter again.” This means the request WAS NOT submitted.  This is 
caused by entering the principal rule number incorrectly, for example: 000-
1-1 when it should be 000-1-01.Click the BACK button; complete the form 
properly, and then click Submit.
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Event #3: The text at the top of the form reads “Rule Number&has already been 

entered. Would you like to edit the rule number or download the rule?” This means 
the rule number is in the Website’s data file (usually due to a previous request). 
***This is the Event you want to see.***

To submit your request to LSC perform the following steps:     

1. Click the Edit option.



2. Locate the rule number you want to submit and click the Edit option.

50



3. Complete the form and click Submit to send your request to LSC.

51
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Modifying a previously submitted request:

1. Click on the Change rule filing schedule option.
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2. Select Agency Number from the drop-down list.

3. If applicable, enter a Division Number; otherwise leave it blank.

4. Click Submit.



54

5. To modify a request click the Edit link. To delete a request click the     
Delete link. Make sure you select the correct Rule# with either option.

NOTE: If you choose the Edit? option, you will need to complete the 
request form.
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6. Complete the form and click Submit to send your request to LSC.
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Downloading prepared rules:

1. Click the Download prepared rules option.



2. Select the Agency Number from the drop-down list.

3. If applicable, enter a Division Number; otherwise leave it blank.

4. Enter a Chapter and click Submit.

57



5. Locate the rule to download and click on the link.

58
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Be aware! If you click the Open 

button, the following error message will 
display:

6. Click the Save button to save the file to your computer.

Always use 

RAS to open 

XML files.
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EXERCISE 1

Downloading a Rule 

from the LSC Register 

of Ohio Website
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Open RAS

A user will click on the Open 

Rule or Open Folder option 
from the File Menu

depending on the desired 
action.

A user will click on the Open Rule or Open Folder icon from 
the Toolbar depending on the desired action.

OR
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Opening a Rule

To open a rule for editing in RAS, a user can select File, Open Rule

from the File Menu. A user can also click the Open Rule icon on the 
Toolbar. Either option will allow the user to browse to a folder on the 
file system and open the rule. 

OR
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Opening a Folder

To open a folder, a user can select File, Open Folder from the File 

Menu. A user can also click the Open Folder icon on the Toolbar. 

Either option allows the user to browse to a folder on the file system

that contains multiple rules stored in one folder.

OR
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Opening a Folder Continued%

The Open Folder option allows a user to bring an entire folder, and 

consequently multiple rules, into the Navigator Panel at one time. See 

example:

The folder structure must be created on your PC first. The folder 

structure cannot be created in RAS later through the Navigator Panel. 
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2. Creating a New Rule
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Creating a New Rule

A user will click on the New 

RAS Document option from 
the File Menu to create a 
new rule.

A user will click on the New RAS Document icon from the 
Toolbar to create a new rule.

OR



67

Creating a New Rule

The New RAS Document box appears. 
When assigning a 
rule number, 
remember the 
Agency, Chapter, 
and Rule fields 
are required. Only 
add a Division 
and/or 
Supplemental 
number if 
applicable. 

NOTE: Agency 
number is retained 
and automatically 
populated the next 
time a new rule is 
created.
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Creating a New Rule

The Tagline; also 
known as the rule’s 
title, should be 
entered for the new 
rule. (This is a free-
format field.)

RAS will 
automatically add a 
period at the end of 
the tagline. This is 
the only place RAS 
adds punctuation. (If 
the user also enters 
a period, RAS will 
delete one so that 
only one appears.)
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Creating a New Rule

A user can create 
a rule with an 
intro; first level (A); 
and/or an outro 
paragraph already 
inserted by 
checking the 
box(es) that 
correspond to the 
desired option.

NOTE: Selections 
from the previous 
entry are retained 
and automatically 
populated the next 
time a new rule is 
created.
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Creating a New Rule

If a user wishes to 
cancel the creation 
of the new rule, 
click the Cancel

button. 

When finished 
entering the 
information, click 
Finish to continue 
entering text for 
the new rule.
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Creating a New Rule

Based on the rule information entered on the 
previous screen, the rule appears in the Edit 
Panel; the outline of the rule appears in the 
Outline Panel; and the rule, 4729$0-5-25-
Rule-N.xml, appears in the Navigator Panel.

The user may begin entering text, inserting 
levels, etc. for the rule; however, it is highly 
recommended that the user first select File, 
Save As to save the rule file before proceeding.
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Creating a New Rule

When creating a new RAS document, always perform 
the following steps:

1. Create the New RAS Document entering the 
appropriate rule related information in the New RAS 

Document box.

2. Click Finish.

3. Click File, Save As and save the 
rule file in the desired location.

Saving RAS Files

Best 

Practice
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Creating a New Rule

The Save As box appears with the File name

created automatically by RAS. It is highly 
recommended that the user retain the File 

name assigned by RAS. 
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Creating a New Rule

Let RAS name your files

When you save a document as an XML, RAS automatically 
generates a file name based on the following information:

1. Rule number, 2. Type of document, and 3. State of the document

Example of a RAS File Name: 4321$0-4-26-Rule-N.xml

4321$0-4-26   The rule number.  RAS inserts a $ (dollar 
sign) between the agency and division numbers and 
inserts a 0 (zero) when there is no division;  

-Rule indicates this document is a rule or rule body;

-N indicates this is a new rule
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Creating a New Rule

Click the Save button to complete the save 
process.
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Creating a New Rule

When attempting to save a RAS document, if an error 
message appears such as the one below, RAS is 
unable to save the document in the destination location 
specified. This is usually a permissions issue and can 
be resolved by contacting your System Administrator. 

Choose another location to save the file and then 
contact an IT person regarding questions about saving 
files to specific locations.
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EXERCISE 2

Creating a New Rule



Overview of RAS Menu Commands
• FILE Menu

• EDIT Menu

• INSERT Menu

• Paragraph Options

• Level Options

• TOOLS Menu

• Merge Options

• Split Options

• TABLE Menu

• Merge Cells Options

• HELP Menu

• Right-Click Menu in Edit Panel

• Right-Click Menu in Navigator Panel 

NOTE: The options displayed for
each menu are based on the
location of the insertion point 
when a menu is accessed. 
Therefore, not all options are 
available at all times.

78
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Overview of RAS Menu Commands – The FILE Menu

Save Saves the file as an .xml document type.

Save AsR Saves a copy of the new RAS document; or creates a 
copy with a different name, and/or puts the file in a 
different location; and/or changes the file type; without 
overwriting the existing file. 

Open Rule Locate and select the rule file to open.

Open Folder Locate and open multiple rules stored in one folder. 

New RAS 
Document

Create a brand new RAS document.

PDF Preview Renders a pdf of the rule exactly as the rule will appear 
when rendered and filed in ERF. This pdf can be saved 
and the filename can be altered to one that is useful to the 
user. The ***DRAFT – Not Yet Filed *** notation is inserted 
at the top.

Export to RTF Saves a rule document as an RTF file. (RTF files can be 
opened in Microsoft Word.)

Exit Closes the RAS application.
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PDF Preview
Select File, PDF Preview or click on the PDF Preview icon       on the 

toolbar. 

From this: To this:

NOTE: RAS is only compatible with Adobe PDF creation products.



PDF Preview

PDF Preview renders a pdf version of the rule exactly as it will appear 
in the ERF Website; in color to show changes/markup. From this view, 
a user can print the document by selecting File, Print or by clicking on 
the Print icon from the toolbar. 

81 
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PDF Preview

From this view, a user can also save the document by selecting File, Save 

As. (Note that the Save icon is not available from the toolbar at this time.)

When viewing a PDF Preview version of the rule document, note that a string of 
random numeric characters will automatically be added to the end of the 
filename as shown here in red:

This automatic, random extension will change every time the rule document is 
viewed via PDF Preview. It is recommended that users remove all extra 
characters after the first .pdf when saving the file to avoid having multiple 
versions of the rule document saved.
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Export to RTF
A user can use the Export to RTF functionality to save a rule document 

as an RTF file. RTF files can be opened in Microsoft Word and then saved 

and/or printed from this view. Have the rule file open, then select File, 

Export to RTF. 
From this: To this:
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Export to RTF

The Save As box will appear prompting the user to save the .rtf version of the rule
file. The File name: field will already be populated with the rule number. Likewise, 
the Save as type: field will have the Rule RTF File type selected. The user simply 
needs to select the location where the .rtf rule file is to be saved and click Save.
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Export to RTF
When the RTF version is opened using Word, it will be in color to show new text, 
stricken text, etc. From this view, a user can print the document by selecting File, 

Print or by clicking on the Print icon from the toolbar. 
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Sharing RTF and PDF File Formats

NOTE: RTF and PDF file formats can be saved and shared with non-RAS 
users. 
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Undo User can undo an action or series of actions, 
one at a time, in the order in which the actions 
were taken.

Redo If an action has been undone, redo can be 
used to take the action again. (This function is 
currently disabled.)

Find/Replace Find and/or replace what is specified in the 
dialog box. 

Delete User can strike highlighted text, remove new 
elements, and remove new levels. Also deletes 
single characters when new text is being typed 
into existing text.

Cut User can only cut and paste new text, not 
existing or stricken text.

Copy User can copy and paste new, existing, or 
stricken text.

Paste User can copy and paste from a document 
where new text is allowed.

Overview of RAS Menu Commands – The EDIT Menu
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Find and Replace
Functional in both new and existing text, a user may find and/or replace 

what is specified in the dialog box. When using this feature, make sure 

the “Wrap search” (to ensure the entire document is searched) and 

“Whole Word” options are checked.
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Find and Replace

For example, if a user searches for the word “rule” and elects to 

replace it with the word “rules” in existing text, find and replace will 

strike the existing word and insert the replacement word as new text.
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Symbol Inserts an entity from another character 
set.

Page Break Inserts a page break. The page break is 
displayed as an actual page break when 
viewing the document from the ERF 
Website. (Displays -----PAGE BREAK-----

inside RAS.)

Paragraph Inserts a new paragraph (not lettered or 
numbered).

Graphic Inserts a graphic file into a RAS 
document (.jpg or .gif).

Insert Table Creates and inserts a new table.

Level Creates a lettered or numbered 
paragraph at a higher rank (Super), the 
same rank (Another) or a lower rank 
(Sub) relative to the location of the 
cursor.

Overview of RAS Menu Commands – The INSERT Menu
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Place the cursor in the text where you want to insert a special symbol. 
(NOTE: You cannot insert a symbol within existing text).

Select Insert, Symbol from the Insert Menu or click on the Symbol 

icon from the Toolbar. A Select Symbols box appears. Notice there is a 
drop-down box with three options. Select an option from the drop-down 
list to reveal the symbol to insert and then click on the desired symbol.

Inserting Symbols
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Inserting Symbols

When a symbol has been selected, it appears in the Selected 

Symbol(s): box. Click Insert to be returned to the Edit Panel where the 
selected symbol is placed within the rule body. The symbol will appear in 
orange, underlined in blue. Example: ™

If you copy and paste text from a Word document that contains a symbol 
from a character set that RAS does not support; i.e. math symbols or 
auto-formatting characters; the following message may display:

Copying Symbols from other documents

NOTE: If a user accidently selects the wrong symbol, it cannot be removed 
from the Selected Symbol(s): box. The user would need to click Cancel, 

exiting the Select Symbols action, and start over to select the correct symbol.

NOTE: Nothing will display in place of the symbol that could not be pasted.
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Copying symbols from other documents

Review the information pasted into a RAS document to determine if any 
symbols were omitted. Omitted symbols can be re-entered using one of 
the following methods:

1. Enter the symbol in RAS by selecting Insert, Symbol from the Insert 

Menu or click the Symbol icon from the Toolbar. 

2. Re-enter it as a regular keyboard character.

3. If the symbol is not available in the RAS symbol selection, enter it as a 
verbal description such as “less than or equal to.”

If problems still persist or if the symbol does not display properly at the 
ERF Website, contact the ERF Help Desk.
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Standard Inserts a new paragraph (not lettered or 
numbered).

Above Any 
Sub-Level

Inserts a new paragraph between the 
level and the first sub-level.

Below Any 
Sub-Level

Inserts a new paragraph after the last sub-
level.

Overview of RAS Menu Commands –

The INSERT, PARAGRAPH Menu
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Paragraph 

Type

Example

Standard

Above 

Any Sub-

Level

Below Any 

Sub-Level

The INSERT, PARAGRAPH Menu
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Super Creates a lettered or numbered 
level at a higher rank relative to 
the location of the cursor.

Another Creates a lettered or numbered 
level at the same rank relative 
to the location of the cursor.

Sub Creates a lettered or numbered 
level at a lower rank relative to 
the location of the cursor.

Overview of RAS Menu Commands –

The INSERT, LEVEL Menu
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Level Example

Super If the cursor is in level (A)(1)(a), inserting a super level will 
insert level (A)(2).

Another If the cursor is in level (A)(1)(a), inserting another level will 
insert level (A)(1)(b).

Sub If the cursor is in level (A)(1)(a), inserting a sublevel will 
insert level (A)(1)(a)(i).

The INSERT, LEVEL Menu



98

The INSERT, LEVEL Menu

Below is an example of having inserted Super, Another, and Sub Levels 
into a rule document:
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EXERCISE 3

Working with Levels
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Edit Rule 

Number

This option is only available for a new 
document. This menu command is the 
only method available for editing a rule 
number.

Strike Used when amending a rule and 
working with existing text, paragraphs, 
levels, graphics, or tables.

Reinstate 

Strike or 

Move

Used to revert stricken text, paragraphs, 
levels, graphics or tables to the previous 
state. This command is also used to 
revert merged or split text to its previous 
state.

Remove New 
Element

Used to delete new text, paragraphs, 
levels, tables, and graphics.

Superscript Used to start typing new text in the 
‘superscript’ format.

Subscript Used to start typing new text in the 
‘subscript’ format.

Overview of RAS Menu Commands – The TOOLS Menu

Continued%
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Edit Rule Number
Editing the rule number is an option only available for new documents. 
This option is exercised anytime a user wishes to change the rule 
number from what was entered originally. 

The user will open the new rule 
document in RAS and click on 
Tools, Edit Rule Number. The 
Edit Rule Number box 
appears with the original rule 
number information populated 
as seen on the right.

The user enters the rule 
number changes and clicks 
Finish. (The user can cancel 
this process at any time by 
clicking the Cancel button.)
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Edit Rule Number

Once the user selects Finish, a new document is immediately created 
and opened in the Edit Panel. Notice that the original document file is  
still open and available. Both documents are also listed in the Navigator 
Panel.

Users need to be cautious of the              
various versions of a rule that are open and 
should try to maintain an organized list of 
files, or edit filenames to better identify the 
documents.
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Promote Increases the rank of the selected level. (RAS 
renumbers all subsequent levels.)

Demote Decreases the rank of the selected level. (RAS 
renumbers all subsequent levels.) Can only demote 
when there is a supporting level above the current 
level.

Merge 

(move up)

Combines two existing levels or paragraphs into one 
by moving existing text to either a new paragraph 
above the current level or added above the current 
level to the end of an old paragraph, level, or super 
level.

Split (move 
down)

Divides one new or existing level or paragraph into 
two by moving the text below the current level to a 
new paragraph, level, or sub level. 

Transform to 

New

Use this command when it is necessary to rescind 
and enter a new rule due to modifying more than 
50% of the rule and adding a comparable amount of 
new text.

Spell 

Checker

Performs spell check on new and existing 
documents. 

Overview of RAS Menu Commands –

The TOOLS Menu Continued
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To 
Existing

Selecting this option will move 
existing text to an existing 
level, follow-on paragraph, or 
a super-level. One cannot 
merge to a sub-level of the 
level above that which you are 
merging from.

To New Selecting this option will create 
a new paragraph that will 
appear as a follow-on 
paragraph from the above 
level.

Overview of RAS Menu Commands –

The TOOLS, MERGE Menu
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To 
Paragraph

Selecting this option will 
create a new follow-on 
paragraph and will capitalize 
the first word from the split.

To Level Selecting this option will 
create a new level and will 
capitalize the first word from 
the split. This will also trigger 
the renumbering of 
paragraphs, if applicable.

To Sub 
Level

Selecting this option will 
create a new sub-level and 
will capitalize the first word 
from the split. This will also 
trigger renumbering of other 
sub-levels, if applicable.

Overview of RAS Menu Commands –

The TOOLS, SPLIT Menu

NOTE: Existing text can only be split once. There is no limit to the number of 
times new text can be split.



Transform to New
The Transform to New function in RAS should be used when it is 
necessary to file a rule as rescind and new due to striking 50% or more of 
the existing text and adding a comparable amount of new text.

A user will open the rule document in RAS and either select Tools, 

Transform to New or click on the Transform to New icon  from the 
Toolbar. The following dialogue box appears:

Click OK to proceed. Click Cancel to stop the rule transformation.

NOTE: Be sure to 
save changes to 
the amended 
document before 
using Transform

to New as it will 
not prompt you to 
do so.

106
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Transform to New

Transform to New creates a new document and inserts all non-stricken 
text as new text. Any stricken text in the amended document is omitted from 
the new document. Now that multiple versions of the rule exist, users need 
to be cautious of what version is chosen from the Navigator Panel.
Original Document: New Document:
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Spell Checker
The Spell Checker function in RAS can be used at any time to check 

for proper spelling throughout a rule document. A user can either select

Tools, Spell Checker or click on the Spell Check icon      from the

Toolbar to initiate this action. When selected, the following dialogue 

box appears:

RAS Spell Checker 
identifies possible 
misspellings by 
comparing the text with 
a database of accepted 
spellings. 

Any word(s) flagged by 
the RAS Spell Checker 
will display at the top, 
one-by-one for the user 
to “process.”
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Spell Checker
The user can type in the correct spelling in the 
Replace With box and then click Change or 
Change All; highlight one of the suggested 
options and click Change or Change All; click 
Add to add the word “as is” to the database of 
accepted spellings; click Ignore Once or 
Ignore All to accept the spelling and leave the 
word “as is” within the document; or Close to 
exit Spell Checker.

� If Change All or Ignore All options are selected, 
all instances of that specific misspelling will be 
changed or ignored throughout the entire rule 
document, depending on what was selected.

� By selecting Add, the misspelling in question will 
be added to the database of accepted spellings and 
will no longer be flagged by Spell Checker as a 
misspelling in this rule document or any other in the 
future.

Once all misspellings have been 
addressed, the Spell Checker 

completed message appears. Click OK.
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Insert 

Table

Prompts user for the number of rows and columns in 
the table, and then will insert the new table into the 
document including the required XML tags.

Add Table Title Inserts a row at the top of the table where a Table 
Title can be entered.

Remove Table Title Deletes a previously added Table Title Row from the 
top of the table.

Insert Row 

Above

Insert a new row above the current position in the 
table.

Insert Row

Below

Insert a new row below the current position in the 
table.

Insert Column 

To The Left

Insert a new column to the left of the current 
position.

Insert Column 

To The Right

Insert a new column to the right of the current 
position.

Delete Row Delete the current row.

Delete Column Delete the current column.

Split Cells Split one cell that has previously been merged into 
two cells.

Merge Cells Merge two or more cells into one cell.

Select Table Selects (highlights) the entire table with a dotted 
orange line.

Overview of RAS Menu Commands – The TABLE Menu
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Select Table Example

To select a table, place the cursor anywhere within the table. Either right-
click and click Select Table or go to Table Menu, Select Table. The 
entire table is selected and surrounded with a dotted orange line.

Once highlighted, click the Strike icon or the [Delete] key to remove or 
strike the entire table, depending on the situation. Select Edit, Undo or 
right-click and select Undo to reinstate the table.
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Merge With Left Merge selected cell with cell to 
the left.

Merge With Right Merge selected cell with cell to 
the right.

Merge With Above Merge selected cell with cell 
directly above it.

Merge With Below Merge selected cell with cell 
directly below it.

Overview of RAS Menu Commands –

The TABLE, MERGE CELLS Menu
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About RAS Displays the version of RAS currently 
installed on your computer.

Install New 
SoftwareR

Begins the process necessary to load 
new version(s) of RAS. 

Check for 
Updates

Displays information regarding RAS 
software updates available for 
installation, if applicable. (If updates 
are listed, they should be installed.)

Overview of RAS Menu Commands – The HELP Menu

NOTE: Detailed instructions on how to perform the options available in the Help 
Menu begin on slide 18 within the Check for and Install RAS3 Updates

section. 
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Overview of RAS Menu Commands –

Right-Click Menu in Edit Panel

The Right-Click Menu appears when the 

cursor is in the ‘Edit Panel’ of RAS and 

the user clicks the right button on the 

mouse. 

These same options have been defined 

in previous slides and are accessible 

from various Menu Bar options as well 

as the Standard Toolbar.

NOTE: The only options not 
previously defined are Insert Intro 

Paragraph and Insert Outro 

Paragraph. These two options are 
ONLY available from this menu.
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Insert Intro Paragraph

An intro paragraph is always at the beginning of 
the rule and is not associated with any levels. From
a cursor location anywhere in the rule, Insert Intro 

Paragraph is available in the Right-Click Menu

and will insert a new Introductory paragraph as 
seen below.
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Insert Outro Paragraph
An outro paragraph is always at the end of the
rule and is not associated with any levels. From 
a cursor location anywhere in the rule, Insert 

Outro Paragraph is available in the Right-Click 

Menu and will insert a new outro paragraph.
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Overview of RAS Menu Commands –

Right-Click Menu in Navigator Panel

When the cursor is in the ‘Navigator Panel’ of RAS
and no documents are open, only the Refresh option 
Appears when the Right-Click Menu is used.

If the Right-Click Menu is used when the 

cursor is in the ‘Navigator Panel’ of 

RAS and a document is highlighted and/or 

open, the menu on the left appears.

If a rule is not showing up in the Navigator Panel, the user can select 

Refresh and it will appear. The need for this will be rare if File, Open 

Rule is always used. 
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EXERCISE 4

Removing New Levels, 

Creating a Table, 

Inserting Paragraphs



Creating an Outline 

Structure in RAS 

119
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NEVER insert an un-numbered 
paragraph and type in your own 
numbering!

ALWAYS let RAS create and 
control the outline lettering and 
numbering.

Creating an Outline Structure in RAS
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Creating an Outline Structure in RAS
When creating an outline structure in RAS, use one of the following two

options to proceed:

1) Use [Ctrl-Enter] to add levels and then Promote and/or Demote

the levels to create the desired outline structure.

The Promote feature in RAS is the opposite of Demote, in that a 
user can move a level up from its current location.

(Demote once.)

(Demote twice.)

(Demote once.)

(Demote once.)

(Demote twice.)

(Demote twice.)

(Becomes (B) due to demotes)

(Highlight (a), Promote)

(Highlight (1), Promote)
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Guidelines for using Promote and Demote:

� Promote/Demote arrows in the toolbar are accessible (active) only 
when a promote or demote is allowed AND&

� When the level to be promoted or demoted is selected.

� Both New levels and Existing levels can be promoted or demoted.

� RAS automatically re-numbers the rule in response to a promote 
or demote.

� When a level is promoted or demoted, the sub-levels and 
paragraphs that are part of that level will move with the promote 
or demote.

� If, through a series of promotes and demotes, the intent of the rule 
is changed, contact LSC before proceeding. In other words, just 
because RAS allows text to be moved, that does not mean that it 
is the right thing to do.

Creating an Outline Structure in RAS
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Creating an Outline Structure in RAS

2) Use the Insert, Level functionality to create the desired outline 
structure. 

Once an outline structure has been created, the user can begin 

inserting text. This can be accomplished by 1) typing the information

directly into the rule document OR 2) copying and pasting the

information from a file created previously. 

(Within (A), Insert Level Sub)

(Within (1), Insert Level Another)

(Within (2), Insert Level Sub)

(Within (B), Insert Level Sub)

(Within (1), Insert Level Sub)

(Within (a), Insert Level Another)

(Within (A), Insert Level Another)
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Copying and Pasting 

Text into a RAS Document

PASTE



Important Reminders!

1. The Rule Outline Structure should be entered first if copying and 
pasting text level by level or paragraph by paragraph, otherwise&

2. Pasting a large section/group of text all at once and then splitting the 
new text into various levels and/or paragraphs as applicable might be 
easier. (The ‘Split New Text’ feature will be discussed beginning on slide 130.)

3. Paragraphs can be copied and pasted into a RAS document; however 
levels (the outline structure) cannot.  

Copying and Pasting Text 

No!

125
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Important Reminders!

4. Copy and paste one paragraph at a time.

5. When text is pasted into RAS be sure to review the results and 
remove any unwanted characters.

Copying and Pasting Text

NOTE: In this example selecting the paragraph mark at the end of 
the text is what causes the (A) to be pasted in the RAS document.
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Important Reminders!

6. Be aware of copying auto format features such as copyright © or 
degree ° symbols.  These types of features may cause problems when 
attempting to paste them into a RAS document, saving the file as an 
XML document, or uploading the file to the ERF Website.  Upon 

viewing the document at the ERF Website be sure to carefully 

inspect the document to ensure it converts properly.

Copying and Pasting Text
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NOTE: Currently, RAS does not support the pasting of tables into a RAS 
document. While blank tables and even table titles can easily be 
incorporated into a RAS document, the information contained 
within the table will need to be manually entered or pasted cell by 
cell.

A future enhancement will enable users to copy and
paste tables into RAS.

Copying and Pasting Text
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EXERCISE 5

Copying and Pasting 

Text, Using Promote 

and Demote Features
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Split New Text
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Split New Text

Splitting New Text is a feature that divides a paragraph of text by 
moving it below the current level to a new paragraph, level, or sub 
level. Whether text is typed into a rule document or pasted; it does not 
matter. Below is an example of new text entered for a rule: 

In order to split the new text into separate paragraphs, levels, or sub 
levels, place the cursor in the new text where the information is to be 
split. (The black line represents the blinking cursor placement.)
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Split New Text

Select Tools, Split, To Paragraph OR click on the down arrow beside 

the Split icon on the toolbar        where the Split drop-down box will 

appear to select To Paragraph:

Here is the result:

Notice that the new text was split and a new paragraph now exists.

To split new text into a level, follow the same steps; except this time 

instead of selecting To Paragraph, select To Level.
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Split New Text

Again, the cursor is placed in the new text where the information is to 
be split. Select Split, To Level as mentioned previously.

Here is the result:

Notice that a new level (I) was created from the split text and the 
existing level (I) was stricken and made level (J).
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Splitting new text gives the user a great deal of flexibility 
to move information within the rule document. With that 
flexibility comes some precautionary reminders for 
which users should be aware:

� RAS allows new text to be split even in the middle of 
a word or sentence. Make sure the cursor is in the 
correct location!

� Watch for extra characters, spaces, etc. to ensure 
that the document is correct.

� Be sure to fix punctuation.

Split New Text
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Working with Words Text
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What Type of Text is It?

Text Type Color

New Blue font color and underlined.

Existing Regular font color.

Stricken Red font color and strikethrough.

Entity (symbol) Orange font color with blue underline.

Merge or Split Gray font color represents where the text 
was removed from. Bold font style 

represents where the text was moved 

to.
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Selecting Text, a Paragraph, or a Level

Task Process

Select a  
word(s)

Click and drag to highlight the word(s).  

or

Double-click to select a word. 
(This action also selects the space following the word)

Select a 
paragraph or 
only the text 
in a level

Click and drag to highlight the paragraph.

NOTE:  When working with paragraphs you can only 

select one paragraph at a time.

Select a level To select a level, click in the margin to the left of the 
level or click on the letter or number inside the 
parentheses of the level to be selected. Single click to 
select the level and any associated sublevels.

NOTE:  When working with levels you can only 

select one level at a time.



Inserting New Text

Task Process Toolbar button
(if available)

Insert a new 
word(s)

Place the insertion point where the 
new text is to display. Type the text. 

Insert a new 
paragraph

Select Insert, Paragraph

or

Press the [Enter] key.

Insert a new 
level

Select Insert, Level and choose 
Super, Another or Sub from the fly-
out menu.

Also, [Ctrl-Enter] has the same 
functionality as “Insert Level Another.”

Super

Another

Sub

When inserting a new paragraph or a new level, place the cursor in the 
paragraph or level that the new paragraph or level will follow. To insert an 
introductory paragraph in the rule, place the cursor in the tagline and hit 
[Enter]. Intro and Outro paragraphs can also be inserted by selecting one of 
those options from the Right-Click Menu discussed on slides 114 and 117.

!
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Editing and Removing New Text

Task Process Toolbar 

Button
(if available)

Edit/Delete 
characters or 
words

Use the [Backspace] or [Delete] keys.

NOTE: Use caution when pressing and holding 
down on the [Backspace] or [Delete] keys as this 
could cause new text to be removed and existing 
text to be stricken.

Delete a 
block of new 
text

Highlight the text or place the insertion point 
anywhere in the new text. Select Tools, Remove 

New Element.

Delete a new 
paragraph

Place the insertion point anywhere in the new 
paragraph. Select Tools, Remove New Element.

Delete a new 
level

Select the level. Select Tools, Remove New 

Element.

NOTE: This action will also delete any associated 
sublevels.
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Striking Existing Text

Task Process Toolbar button
(if available)

Strike a 
word(s)

Highlight the text. Select Tools, Strike.

or

Press the [DELETE] key.

Strike a 
paragraph

Click anywhere in the paragraph. Select 
Tools, Strike.

Strike a level Select  the level you want to strike. 
Choose Tools, Strike.  This action will 
also strike any associated sublevels.

To strike only the text in a level and not 
the level, click anywhere in the text and 
select Tools, Strike.
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Reinstating Stricken Text

Task Process Toolbar button
(if available)

Reinstate a 
word or words

Click in the stricken text. Select Tools, 

Reinstate Strike or Move.

Reinstate a 
paragraph

Click in the stricken paragraph. Select 
Tools, Reinstate Strike or Move.

Reinstate a 
single level 
(even if it has 
sublevels)

Click in the text of the stricken level you 
want to reinstate. Select Tools, 

Reinstate Strike or Move.  

Reinstate a 
level and 
associated 
sublevels

Select the level.  

Select Tools, Reinstate Strike or Move. 
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Amending a Rule
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Amending a Rule

Context Bar: 

Important Reminders!

1. If you are unable to type new text following stricken text, it could be 
due to the location of your cursor. If the Context Bar displays “old” at 
the end, press the right arrow key on your keyboard until the word “old” 
no longer displays at the end of the Context Bar. 

2. RAS does not renumber internal cross-references if the referenced 
level has been renumbered due to inserting or striking levels.
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EXERCISE 6

Amending a Rule 
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File Management in RAS
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File Management in RAS

Save Your Work 

Frequently!!!

There is no auto-save feature 
in RAS, therefore if you are not 

saving your work, it is not 
being saved!!!
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When you close 
a document and 
changes have 

not been saved, 
RAS will notify 

you and provide 
the opportunity 

to save the 
changes.  

File Management in RAS

Be Aware of Prompts to Save Your Changes.

Saving Files
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File Management in RAS

Save As and Linked Files

Notice the three files saved 
within the open folder. There is 
no visible indicator that those 
files are linked; however, the 
folder that they are in has an 
arrow icon indicating that it is 
linked. By default, files within a 
linked folder are linked files.

Using the “Save As” 
functionality in RAS creates a 
“linked file.” An arrow icon 
displays beside the rule in the 
Navigator Panel for each file 
that is linked. See examples:
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File Management in RAS

Broken Link

If the file that is linked to RAS is moved or deleted, 
a small yellow square with a black exclamation 
point appears next to the filename in the Navigator 
Pane. 

See example: 
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File Management in RAS

Broken Link Continued%

If this rule is opened, an error message appears in the Edit Panel advising 
the user to try opening the rule using File, Open Rule. If problems opening 
the rule continue, the user is advised to contact the ERF Help Desk. 

NOTE: This message will eventually 
be removed; however if you receive it, 
the scenario explained above is the 
reason why. Click OK to complete the 
deletion; Cancel to stop the deletion. 

The rule can be restored using File, Open Rule to open the rule from its new 
location if it had been moved; however, if the rule was deleted, the file cannot be 
restored. The user should delete the rule from the Navigator Panel so that it is no 
longer listed. Doing so will generate the message below. 
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File Management in RAS

Broken Link Continued%

Another scenarioRA file is opened in RAS and then RAS is closed 
with the file still open. The file is then moved; breaking the link in RAS. 
When RAS is re-opened, the following message will immediately 
appear at the top of the Edit Panel:

The user can restore the link using File, Open Rule to open the rule 
from its new location. This action restores the link to RAS and the rule 
file opens in the Edit Panel. The Navigator Panel also reflects that the 
rule file is linked again.  
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xml – A rule body that does not contain graphics is saved as an xml file. 
(Slide 10 has additional information.)

zip – A rule body that contains graphics is saved as a zip file.

rtf – A rule body can be exported from RAS as an rtf file and can then be 
opened in Microsoft Word. The rtf can be printed and/or saved. 

pdf (preview) – A rule can be rendered as a pdf exactly as it will be 
rendered by the ERF System when it is filed. The pdf file can be printed 
and/or saved.

File Management in RAS

File Formats
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Inserting 

Graphics
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In rare cases, a rule will need to include a graphic (also known as figures, 
pictures, or images). 

Graphics should be used only when necessary and must be one of the 
following two file formats:

.gif = Graphics Interchange Format

.jpg = Joint Photographic Experts Group

DO NOT use portable network graphics (.png) or bitmap (.bmp) formats as 
these format types are too large.

You also cannot use WINZIP or other software to create a rule ZIP file –
only RAS. The Electronic Rule Filing (ERF) Website will only accept ZIP 

files created in RAS.

Inserting Graphics
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In RAS, the width of the graphic must be greater than the height AND the 
height of the graphic cannot exceed 600 pixels.

Inserting Graphics

Bad% Good!Graphic Width less than Height

Graphic
Graphic

Graphic Width more than Height

W i d t h
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NOTE: When rules with graphics are saved in RAS, they are saved in ZIP 

format. If either size requirement is not met you will not be able to upload 
the .zip file to the ERF Website and the message below will appear.
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To insert a graphic into a rule body, the user must:

1) Open or create the rule document that will contain the graphic.

2) Determine where in the rule the graphic needs to be inserted.

3) Click the cursor in the text above that location as the graphic will be 
inserted in the next logical position beneath the location of the cursor.

4) Select Insert, Graphic OR

click on the Insert Graphic icon from the toolbar. 

Inserting Graphics
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5) The “Open” dialog box will appear so that the graphic file can be 
located. Find the desired file and select the graphic to be inserted 
into the rule document. (Remember, the file must be a .jpg or .gif.) 

6) Click Open or Double-click the graphic file.

Inserting Graphics
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The graphic will be inserted in the next logical position beneath the
location of the cursor and it will be center-aligned within the rule
document. Neither the alignment nor the spacing can be changed.

Inserting Graphics
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Saving Inserted Graphics

As mentioned previously, when a rule containing a graphic is saved in 
RAS, the file is saved in ZIP format. Whether a user saves the rule 
document by selecting File, Save As or clicks on the Save icon on the 
toolbar, as soon as the SAVE action is taken, the .zip file is created.

Notice in the Navigator Panel the original .xml file format exists, as well 
as the new .zip file format.

The rule is now saved as a ZIP file type and also as an XML file type 
but only the .zip file contains the graphic.
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Editing or Re-opening a Rule with 

Graphics

If changes need to be made to the rule document after a graphic has 
been inserted, ALWAYS open and edit the .zip file version of the rule; 
not the .xml version. Double-click on the .zip file version of the rule 
from the Navigator Panel and modify the rule document as needed. 

(When the rule opens, check for the graphic. If it is not visible, make 
sure the .zip version of the rule was selected. If the .zip file is open, 
contact the ERF Help Desk.)

Save changes periodically!
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Removing or Striking a New Graphic 

from a Rule

To REMOVE a “new” graphic (bordered by a blue box):

- Click in the center of the graphic you want to remove. A 
dotted orange box appears around the graphic.

- Press the [Delete] key or click on the Remove New 

Element icon      on the toolbar.
- The graphic will disappear.

If all new graphics are removed from a rule, when the rule is saved it 
will not be saved as a .zip file. It will instead be saved as an .xml file. 
Any text edits made before removing the graphic(s) will be saved in the 
.xml file.
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Removing or Striking an Existing  

Graphic from an Existing Rule

To STRIKE an existing graphic in an existing rule:

- Click in the center of the graphic you want to strike.
- Press the [Delete] key or click on the Strike icon      on 

the toolbar.
- A dotted orange box will appear around the graphic 

and a red “X” will appear through the center of the 
graphic. See example below:
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In this class you learned%

• Key terms and concepts.

• RAS basic skills for creating new rules and 
amending rules, saving RAS documents, 
and working with text and levels.

• The process of requesting and downloading 
rules from the Rule Filers Website.
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What are the next steps?

 Load the RAS3 

Software.

 Attend an ERF 

Website course!
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For any questions about RAS or 

Electronic Rule Filing,

call the 

ERF Help Desk

614-387-2078

Monday – Friday
8:00 am – 5:00 pm

Email:  erfhelpdesk@lsc.state.oh.us
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Appendix A

RAS Keyboard Shortcuts



RAS Keyboard Shortcuts

Enter key Pressing the [ENTER] key in a RAS document will insert a 
paragraph (except from the tagline).

Delete key The [DELETE] key will strike highlighted amended text, remove 
new elements (i.e. graphics, page breaks, follow on paragraphs, etc.), and 
remove new levels.  In addition, pressing the [DELETE] key will remove single 
characters of new text. 

[Ctrl-Enter] – Pressing the [CTRL] and [ENTER] keys at the same time will 
insert a new level at the same rank relative to the current cursor location.

List of General Key Options for RAS

Close Ctrl + W Refresh F5

Close All Ctrl + Shift + W Reinstate Strike or Move Shift + Alt + Y

Copy Ctrl + C Remove New Element Ctrl + Shift + 3

Cut Ctrl + X Save Ctrl + S

Demote Shift + Alt + O Select All Ctrl + A

Edit Rule Number Shift + Alt + E Split to Level Ctrl + Shift + [

Find and Replace Ctrl + F Split to Paragraph Ctrl + [

Merge to Existing Ctrl + J Split to Sublevel Alt + [

Merge to New Ctrl + Shift + ] Strike Shift + Alt + K

PDF Preview Ctrl + Shift + M Transform to New Ctrl + 8

Paste Ctrl + V Undo Ctrl + Z

Promote Shift + Alt + P

Redo Ctrl + Y 167



RAS Keyboard Shortcuts

Graphic Ctrl + I

Level – Another Ctrl + Enter

Level – Sub Level Ctrl + Shift + Down

Level – Super Level Ctrl + Shift + Up

Paragraph Enter

Symbol Shift + Alt + B

Table Ctrl + T

List of Insert Key Options for RAS

List of Table Key Options for RAS

Delete Column Ctrl + Shift + 4

Delete Row Ctrl + 4

Insert Column to Left Ctrl + 2

Insert Column to Right Ctrl + Shift + 2

Insert Row Above Ctrl + 1 (the number 1)

Insert Row Below Ctrl + Shift + 1 (number)

Insert Table Ctrl + T

Move to Next Table Cell Tab

Move to Previous Table Cell Shift + Tab

Split Cells Ctrl + 6
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